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2019 Total Knee Replacement

Preface
Dear Data Submitters,
Attached is our 2019 Total Knee Replacement (TKR): Functional Status and Quality of Life Measures. We
truly appreciate your medical group contributing data on quality and patient outcomes. Your
involvement is vital to MN Community Measurement’s ability to achieve our mission to empower health
care decision makers with meaningful data to drive improvement.
We want to support your success as well by providing resources, tools and reports that your medical
group or clinic can use for quality improvement.
The following resources can be found on our corporate website, MNCM.org:
•

•
•
•
•

Public reports including the Health Care Quality Report, Heath Equity of Care Report, Health
Care Disparities Report, Total Cost of Care Report, and topic specific reports released throughout
the year
Patient education and engagement resources
Provider tools and resources
Educational webinars throughout the year
Health Trackers

Additionally, the following resources can be found on the secure MNCM Data Portal:
•
•

Detailed reports and charts of clinical measure results
Charts of specific clinical measure results segmented by race, Hispanic ethnicity, preferred
language and country of origin (REL) for medical groups following best practices

Finally, on MNHealthScores.org, you will find public-facing results of all measures for clinics, medical
groups and hospitals. As this is our consumer-focused site, it has less detail than is available in our
reports and on the Data Portal.
MNCM is committed to working with multi-stakeholder committees to champion the highest value
measures that will make the most impact in our community, while minimizing burden on organizations
that supply the data. And as performance results improve, we have processes in place to retire
measures as appropriate.
Thank you again for your important role in our work. If you have questions, feel free to contact us at
612-746-4522 or support@mncm.org.

Anne Snowden, MPH, CPHQ
Director, Performance Measurement, Validation & Reporting
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2019 Total Knee Replacement
Summary of Changes
Summary of Changes
A. Measure Specification Changes from Previous Year
NONE

B. Field Specification Changes from Previous Year
1. Language regarding Patient Sex updated for clarity (Column D).
See Data Elements and Field Specifications table for further detail.

C. Other Changes from Previous Year
1. Mercy Hospital – Unity Campus merged with Mercy Hospital (Coon Rapids) in Table 1 (Appendix
B).
2. Clarification surrounding alteration of Patient Reported Outcome (PRO) tools added to Appendix
C.

D. Changes from Draft to Final
1. Minor edits to Preface cover letter.
2. Removal of instructions to complete Pre-Submission Quality Checklist (Sec III-B).
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2019 Total Knee Replacement
Measure Specifications
Measure Specifications
Measure

Total Knee Replacement: Average change in functional status

Description

The average change (preoperative to one year post-operative) in functional
status for patients 18 years of age or older who had a primary or revision
total knee replacement surgery
Results for primary and revision knee surgeries are reported separately.

Measurement Period

Procedure Period: January 1 through December 31, 2017
Preop Assessment Period: October 1, 2016 through December 31, 2017
Postop Assessment Period: October 1, 2017 through March 31, 2019

Eligible Population

Eligible Specialties

Orthopedic Surgery

Eligible Providers

Medical Doctor (MD), Doctor of Osteopathy (DO)

Ages

18 years or older at the start of the procedure period

Primary or revision total knee replacement surgery
(Primary TKR Value Set, Revision TKR Value Set)
performed by an eligible provider in an eligible
specialty during the procedure period
Patients within the eligible population whose functional status was
measured by the Oxford Knee Score within three months preoperatively
AND at one year (+/- 3 months) postoperatively
Event

Denominator

Numerator

The average change (preoperative to one year post-operative) in functional
status for all patients in the denominator

Exclusions

None

Measure Scoring

Number
Results are always stratified as follows:
•

Average change in functional status, Primary total knee replacement

•

Average change in functional status, Revision total knee replacement

Interpretation of Score

Higher score indicates better quality

Measure Type

Outcome
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Measure Specifications
Measure

Total Knee Replacement: Average change in health-related quality of life

Description

The average change (preoperative to one year post-operative) in healthrelated quality of life for patients 18 years of age or older who had a primary
or revision total knee replacement surgery
Results for primary and revision knee surgeries are reported separately.

Measurement Period

Procedure Period: January 1 through December 31, 2017
Preop Assessment Period: October 1, 2016 through December 31, 2017
Postop Assessment Period: October 1, 2017 through March 31, 2019

Eligible Population

Eligible Specialties

Orthopedic Surgery

Eligible Providers

Medical Doctor (MD), Doctor of Osteopathy (DO)

Ages

18 years or older at the start of the procedure period

Event

Primary or revision total knee replacement surgery
(Primary TKR Value Set, Revision TKR Value Set)
performed by an eligible provider in an eligible
specialty during the procedure period

Denominator

Patients within the eligible population whose health-related quality of life
was measured by the PROMIS-10 within three months preoperatively AND
at one year (+/- 3 months) postoperatively

Numerator

The average change (preoperative to one year post-operative) in healthrelated quality of life for all patients in the denominator

Exclusions

None

Measure Scoring

Number
Results are always stratified as follows:
•

Average change in health-related quality of life- physical health, Primary
total knee replacement

•

Average change in health-related quality of life- mental health, Primary
total knee replacement

•

Average change in health-related quality of life- physical health, Revision
total knee replacement

•

Average change in health-related quality of life- mental health, Revision
total knee replacement

Interpretation of Score

Higher score indicates better quality

Measure Type

Outcome
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Measure Specifications
Measure Logic / Flow Chart
Was the patient born on
or prior to 01/01/1999?

2019 Total Knee
Replacement

No

Yes

One Year Measure
Flow Chart

PATIENT NOT
INCLUDED IN
MEASURE

Did the patient have primary or
revision total knee replacement
surgery (Primary TKR Value Set,
Revision TKR Value Set) performed by
an eligible provider in an eligible
specialty during the measurement
period (01/01/2017 to 12/31/2017)?

No

Yes

PATIENT INCLUDED IN
ELIGIBLE POPULATION

Did patient have
pre-op OKS within
three months prior
to procedure?

Yes

Did patient have one
year post-op OKS
within 9 to 15
months post
procedure?

Did patient have
pre-op PROMIS-10
within three months
prior to procedure?

No

No

No

PATIENT NOT
INCLUED IN MEASURE
CALCULATION

No

Yes

Did patient have one
year post-op
PROMIS-10 within 9
to 15 months post
procedure?

Yes

Yes

Patient included in
average change in
functional status
score at one year
measure (Rates
stratified by Primary
vs. Revision TKR)

Patient included in
average change in
quality of life score
at one year measure
(Rates stratified by
Primary vs. Revision
TKR)
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Process and Timeline Overview
Process and Timeline Overview
Process Step
Registration
Registration must be completed prior to data submission. Please refer to the
Clinic and Provider Registration Instructions guide available on the Resources
tab of the MNCM Data Portal as well as on MNCM.org for additional
information.
Pre-Submission Data Certification
See Section I for more information.
Data Collection and Submission
See Sections II and III for more information.

Preliminary Results Review, Quality Checks
See Sections III-B and IV for more information.
Two-Week Medical Group Review Period of Preliminary Statewide Results
See Section IV for more information.
Final Data Results

Important Dates
November 2018 to
February 2019

Submit document by
April 16, 2019
MNCM Data Portal is
open for submission
April 15 to May 10,
2019
May-July2019
July 2019
Fall 2019

Sharing Data Files and Protected Health Information (PHI) Securely:
It is important that data files and PHI are shared securely between organizations. Email is
not a secure mode of transmitting data.
• Do not send a data file or patient list that contains PHI to MNCM via email.
• Do not include any identifiable patient information in the body of an email message.
o Examples of PHI include (but are not limited to) the following: patient ID, patient
date of birth, patient name, patient address or zip code, insurance member ID, dates
of service.
Please contact support@mncm.org to determine a secure mode of transmission.
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Resources
Data Submission Resources
The Total Knee Replacement resources page contains useful documents and answers to Frequently
Asked Questions. To access the resources page:
1. Log in to the MNCM Data Portal.
2. Click on the Resources tab.
3. Select Cycle B – Total Knee Replacement from the drop down menu.
a. Download the following documents:
i. 2019 Total Knee Replacement Data Collection Guide
ii. 2019 Total Knee Replacement Pre-Submission Data Certification Form
iii. 2019 Total Knee Replacement Data Collection Spreadsheet Template
iv. Optional: 2019 Total Knee Replacement Data Collection Form. This is a patientlevel form that is most useful for medical groups and clinics using paper records.
v. 2019 Total Knee Replacement Value Set Dictionary. This workbook contains all
Value Sets referenced in this guide.
For questions not answered by the information available on the Resources tab, contact MNCM at
support@mncm.org or 612-746-4522.
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Direct Data Submission
Process Steps
for
2019 Total Knee Replacement

2019 Total Knee Replacement
Agreements & Pre-Submission Data Certification

Section I: Agreements and Pre-Submission Data Certification
Clinic and provider registration as well as the electronic signing of the Business Associate Agreement
(BAA), the Direct Data Submission (DDS) Terms and Conditions, and selection of a Data File Transfer
option must be completed prior to data submission.

A. Business Associate Agreement
A business associate is a person or entity that performs certain functions or activities that involve the
use or disclosure of PHI on behalf of, or provides services to, a covered entity. The HIPAA Privacy Rule
requires that a covered entity obtain satisfactory assurances from its business associate that the
business associate will appropriately safeguard the PHI it receives on behalf of the covered entity. Since
MNCM is performing services on behalf of medical groups submitting data that involve the use and
disclosure of PHI, it is necessary for covered entities submitting PHI to MNCM to sign a BAA.
To electronically sign the BAA:
1. Log in to the MNCM Data Portal.
2. Click on the Home tab.
3. Click on the BAA Agreement link under the Total Knee Replacement measure heading.
4. Review the text, click the check box at the bottom of the Agreement and click OK.
a. Once electronically signed, the Agreement applies to all DDS measures and does not
need to be signed again unless provisions of the Agreement change.
b. Failure to electronically sign the Agreement will preclude the medical group from
submitting data.

B. Direct Data Submission Terms and Conditions
Please see Appendix A for detailed information about the DDS Terms and Conditions.
To confirm agreement with the DDS Terms and Conditions:
1. Log in to the MNCM Data Portal.
2. Click on the Home tab.
3. Click on the DDS Terms & Conditions link under the Total Knee Replacement measure heading.
4. Review the text, click the check box at the bottom of the DDS Terms and Conditions and click
Select.
a. Failure to agree to the DDS Terms and Conditions will preclude the medical group from
submitting data for the measure.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
1

2019 Total Knee Replacement
Agreements & Pre-Submission Data Certification
C. Data File Transfer Selection
Beginning in 2014, the Minnesota Department of Health (MDH) has requested the receipt of patient
level data. MDH has assured MNCM that medical groups are permitted to disclose this patient-level data
to MDH under applicable law (including Minnesota law and HIPAA), because it will be used by MDH only
for public health activities, health oversight activities, or other activities required or authorized by state
or federal law. A list of the data elements to be shared with MDH for each measure is available in the
MNCM Data Portal under the Resources tab by selecting Minnesota Statewide Quality Reporting and
Measurement System from the drop-down menu.
MDH will use patient level data to:
•
•
•
•
•
•

Research and analyze health disparities
Design and evaluate public health interventions
Publicly report summary results
Research risk adjustment methodologies
Benchmark and evaluate Health Care Homes
Validate quality measure results

MDH will not use patient level data to pursue investigatory or regulatory activities.
Medical groups must indicate on the MNCM Data Portal whether they choose to allow MNCM to share
patient-level data with MDH.
1. Log in to the MNCM Data Portal.
2. Click on Data Files Transfer on the Home tab in the MNCM Data Portal under the Total Knee
Replacement section.
3. Choose one of the two data sharing options:
YES – My organization agrees to have MNCM share our patient-level data with MDH for
specified measures.
NO – My organization does not agree to have MNCM share our patient-level data with MDH.
3. Click Save.
If a selection error is made, please contact MNCM at support@mncm.org to request a selection change.
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2019 Total Knee Replacement
Agreements & Pre-Submission Data Certification
D. Pre-Submission Data Certification
Prior to data collection, medical groups must supply query source code and/or methodology for
identifying the correct eligible patient population. This ensures groups are applying the measure
specifications correctly. A template document is provided in the MNCM Data Portal Resources tab. The
responsibility of applying the measure specifications correctly rests with the medical group.
To download and complete the template and submit it for certification:
1. Login to the MNCM Data Portal.
2. Under the Resources tab, select Cycle B – Total Knee Replacement from the drop-down menu.
3. Download the Total Knee Replacement Pre-Submission Data Certification Form.
4. Complete and save the form.
5. Login to the MNCM Data Portal and from the Home page click on Denominator Certification
under the Total Knee Replacement header. Follow the instructions to upload the saved form to
the MNCM Data Portal.
MNCM will review the information and will either (1) contact the medical group if more clarification is
needed or (2) certify the methodology. An automatic e-mail will notify the medical group when the
method is certified.
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2019 Total Knee Replacement
Data Collection

Section II: Data Collection
A. Eligible Population Identification
After Pre-submission Data Certification is complete, medical groups identify the eligible population. Save
all original queries, spreadsheets and other documentation of the process used to identify the eligible
population. This information may be requested during validation.

Preparing the eligible population list:
1. Query applicable systems to generate a list according to the eligible population as described in
the measure specifications.
2. De-duplicate the list; one record per procedure.
o Patients with bilateral knee replacements (both knees replaced on the same day, during
the same procedure) should have one record in the list.
o Patients with sequential knee replacements (each knee replaced on a separate day,
during a separate procedure) should have two records in the list, one for each
procedure.
3. Review the number of patients in the population and consider whether the number is accurate.
If not, correct the methodology and/or query.

Total Population
This measure requires total population data submission. The submission of all patients meeting
eligibility criteria is required regardless of the assessment tool completion status. Sampling is not
allowed.

Patient Attribution
The patient is attributed to the surgeon who performs the procedure. The patient is also attributed to
the clinic site where their preoperative visit with the surgeon occurred.
If a surgeon has left the medical group, the patient must remain in the data file if they meet eligibility
criteria.
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Data Collection
B. Data Collection
Data Elements and Field Specifications
Use this section to build your data file for submission. The specifications contain detailed information regarding each column in the submission
file, including column order, definitions, examples, and appropriate formatting.
Summary of Changes

Language regarding Patient Sex updated for clarity (Column D).

Column

Field Name

Notes

Excel Format

Example

A

Clinic ID

Enter the MNCM Clinic ID of the clinic to which the patient is attributed based
on the attribution methodology detailed in Section II.

Text

905

MNCM assigns clinic IDs at the time of registration. Clinic IDs are listed in the MNCM
Data Portal on the Clinics tab. Do NOT use the medical group ID.
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that the ID in each cell matches the clinic ID in the MNCM Data
Portal.
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Data Collection
Column

Field Name

Notes

Excel Format

Example

B

Patient ID

Enter a unique patient ID to identify each patient.

Text

56609

Date
(mm/dd/yyyy)

10/30/1985

Text

F

•
•

The patient’s medical record number may be used.
Medical groups or clinics that choose not to use the medical record number should:
o
o

•

NOT use the patient’s Social Security Number
Maintain a crosswalk between the patient ID and the medical record
number or patient name and Date of Birth (DOB)

Medical groups or clinics that do not have an EHR should also maintain a crosswalk
between patient ID and patient name and DOB as a tool to locate records during
audit.

Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that patient’s procedure was not duplicated. However, if a
duplicate is found, make sure that the patient has undergone multiple separate TKR
procedures during the measurement period.

C

Patient Date of
Birth

Enter the patient’s date of birth.
The date of birth range for this age group is on or before 01/01/1999.
Data Portal Note: A blank field or a value outside of the allowable range will create an
ERROR upon submission.
Quality Check: Verify that each date of birth is within the accepted range

D

Patient Sex
CLARIFICATION
for 2019

Enter the patient’s sex:
F = Female

M = Male

U = Unknown/Undefined

Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has one of the accepted codes.
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Data Collection
Column

Field Name

Notes

Excel Format

Example

E

Patient Zip
Code

Enter the patient’s five-digit zip code of primary residence at the most recent
encounter on or prior to 03/31/2019.

Text

55111

Number

1

Number

2

For more information about collecting this data from patients, refer to the
Handbook on the Collection of Race Ethnicity and Language Data available on
MNCM.org under Submitting Data > Training & Guidance > Data Collection
Guides > Supplemental Specifications.

Text

Country A

Number

1

Quality Checks: Verify that each cell has an accepted code. Blank fields (if no data is
available) are acceptable

Text

Language B

Text

1997993992

If extraction results in a nine-digit zip code, all nine-digits may be submitted. The MNCM
Data Portal will only store the first five digits.
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify the zip code is five digits and that each cell has data.

F

Race/Ethnicity1

G

Race/Ethnicity2

H

Race/Ethnicity3

I

Race/Ethnicity4

J

Race/Ethnicity5

K

Country of
Origin Code

L

Country of
Origin Other

M

Primary
Language Code

N

Primary
Language Other

O

Surgeon NPI
Number

Please refer to a separate document entitled REL Data Elements, Field
Specifications & Codes for Column F-N field definitions and specifications. This
document can be found in the MNCM Data Portal under the Resources tab in the
Race/Ethnicity/Language Data (REL) section, or on MNCM.org under Submitting
Data > Training and Guidance > Data Collection Guides > Supplemental
Specifications.

Enter the ten-digit NPI number of the surgeon who performed the total knee
replacement procedure.
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has data.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
7

2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

P

Provider
Specialty Code

Enter the specialty code of the surgeon performing the procedure:

Number

22

Number

1

Text

WORKERS
COMPENSATION
ONLY

Text

FBZXV1234

Text

715.16

22 = Orthopedic Medicine/ Surgery
Data Portal Note: A blank field will create an ERROR upon submission.
Quality check: Verify that each cell has an accepted code.

Q
R

S

Insurance
Coverage Code
Insurance
Coverage Other
Description
Insurance Plan
Member ID

Please refer to a separate document entitled Insurance Coverage Data Elements,
Field Specifications & Codes for these field specifications. This document can be
found via the link above, in the MNCM Data Portal under the Resources tab in
the Insurance Coverage Field Specs & Codes for DDS section, or on MNCM.org
under Submitting Data > Training and Guidance > Data Collection Guides >
Supplemental Specifications.
Enter codes corresponding to the patient’s most recent insurance on or prior to
03/31/2019.
Quality Check: Verify that each cell has an accepted code and that all 99 codes have a
name entered in Column R. Verify that Social Security Numbers are NOT submitted.

T

Diagnosis Code
OPTIONAL

Enter the patient’s primary diagnosis.
•
•

This diagnosis should indicate the condition for which the knee replacement is
occurring.
If the preoperative and intraoperative diagnosis differs, use the intraoperative
diagnosis.

Quality Check: Verify that each cell has data.
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Data Collection
Column

Field Name

Notes

Excel Format

Example

U

Procedure Type

Enter the code that corresponds to the type of total knee replacement for this
procedure date:

Number

1

Number

62.5

Number

130

1 = Primary Total Knee Replacement
2 = Revision Total Knee Replacement
See Primary TKR Value Set and Revision TKR Value Set to determine appropriate coding
for this field.
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code.

V

Height Inches

Enter the patient’s height in inches.
•
•
•

Submit the value as recorded in the patient record, including decimal points if
applicable.
Height must be collected (measured) in a clinical setting and not a patient reported
value.
Leave BLANK if height is not documented in the medical record.

Quality Check: If data is entered, verify that the value is reasonable for a patient’s height
measured in inches.

W

Weight Pounds

Enter the patient’s preoperative weight in pounds.
•
•
•

Submit the value as recorded in the patient record, including decimal points if
applicable.
Use the most recent weight within six months prior to the procedure. Weight must
be collected (measured) in a clinical setting and not a patient reported value.
Leave BLANK if weight within six months prior to the procedure is not documented
in the medical record.

Quality Check: If data is entered, verify that the value is reasonable for a patient weight
measured in pounds.
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Data Collection
Column

Field Name

Notes

X

Diabetes
OPTIONAL

Enter the code that corresponds to whether the patient has diabetes.
1 = Yes

Excel Format

Example

Number

0

Number

1

Date
(mm/dd/yyyy)

11/10/2017

Text

41

0 = No

The Diabetes Value Set may be utilized but is not the only allowed method for data
collection. Any documentation of a new or existing diagnosis of diabetes is accepted.
Quality Check: Verify that each cell has an accepted code.

Y

Tobacco Status
OPTIONAL

Enter the code that corresponds to the patient’s preoperative tobacco status.
1 = Tobacco free (patient does not use tobacco; patient was a former user and is not
a current user)
2 = No documentation
3 = Current tobacco user (tobacco includes any amount of cigarettes, cigars, pipes or
smokeless tobacco; E-cigarettes are not considered tobacco products)
Quality Check: Verify that each cell has an accepted code.

Z

Date of
Procedure

Enter the date of the total knee replacement procedure.
Data Portal Note: A blank field or value outside of the measurement period will create
an ERROR upon submission.
Quality Check: Verify that each date is within the accepted range.

AA

Facility ID

Enter the code for the facility where the total knee replacement procedure was
performed.
Please see Appendix B for codes.
Data Portal Note: A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code. If 999 is entered, verify that
text is entered in Column AB for this row.
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Data Collection
Column

Field Name

AB

Facility Other
Description

Notes
If the Facility ID (column AA) = 999 Other, enter the description of the location
where the total knee replacement was performed.

Excel Format

Example

Text

Elk Ridge
Surgery
Center

Number

1

Date
(mm/dd/yyyy)

10/27/2017

Number;
Whole
numbers only

23

Quality Check: For all fields with text, verify that code 999 is entered in the Facility ID
field (column AA).

AC

Facility Type

Enter the type of facility in which the total knee replacement procedure was
performed:
1 = Hospital
2 = Free Standing Outpatient Ambulatory Surgery Center
Data Portal Note: A blank field will create an ERROR upon submission.
Quality check: Verify that each cell has an accepted code.

Please see Appendix C for more information about the Oxford Knee Score (OKS) tool.
AD

Preop OKS Date

Enter the date on which the preoperative OKS was completed by the patient.
•
•

If more than one preoperative OKS was obtained, use the OKS that is the most
recent and prior to the procedure.
Leave BLANK if a preoperative OKS was not obtained.

Quality Check: If a date is entered, verify dates are valid.

AE

Preop OKS
Score

Enter the preoperative OKS summary score.
•
•
•

Only include scores for patients who have answered ALL questions, do not submit
scores for partially completed tools.
If the patient selects more than one response for a single question, select the worst
(lower numeric value) response to calculate the summary score.
Leave BLANK if a complete and valid preoperative OKS was not obtained.

Quality Check: If data is entered, verify that each cell has a value between zero and 48.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

Date
(mm/dd/yyyy)

10/27/2017

Number,
Whole
numbers only

3

Please see Appendix C for more information about the PROMIS Global Health 10 (PROMIS-10).
AF

Preop PGH Date

Enter the date on which the preoperative PROMIS-10 was completed by the
patient.
•
•

If more than one preoperative PROMIS-10 was obtained, use the most recent and
prior to the procedure.
Leave BLANK if a preoperative PROMIS-10 was not obtained.

Quality Check: If a date is entered, verify dates are valid.

AG

Preop PGH 1
Health

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding general health rating.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

AH

Preop PGH 2
Quality

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding general quality of life.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

AI

Preop PGH 3
Physical

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding general physical health.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

AJ

Preop PGH 4
Mental

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding general mental health.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

AK

Preop PGH 5
Satis Social

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding general satisfaction with social activities
and relationships.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

AL

Preop PGH 9
Soc Activities

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding ability to carry out social activities and
roles.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

AM

Preop PGH 6
Phys Activities

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding ability to carry out physical activities.
1 = Not at all
2 = A little
3 = Moderately
4 = Mostly
5 = Completely
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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Data Collection
Column

Field Name

Notes

Excel Format

Example

AN

Preop PGH 10
Emotional

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding emotional problems in the past seven days.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Never
2 = Rarely
3 = Sometimes
4 = Often
5 = Always
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

AO

Preop PGH 8
Fatigue

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding fatigue on average in the past seven days.
1 = None
2 = Mild
3 = Moderate
4 = Severe
5 = Very Severe
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

AP

Preop PGH 7
Pain

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding pain rating in the past seven days using a
scale of 0 (No Pain) to 10 (Worst imaginable pain).

Number,
Whole
numbers only

3

Date
(mm/dd/yyyy)

2/9/2018

Number;
Whole
numbers only

31

Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero and ten.

AQ

3 Mon Postop
OKS Date

Enter the date on which the three-month postoperative OKS was completed by
the patient.
•

•

•

The allowable date range for the three-month assessment is nine to 20 weeks after
the procedure date.
o OKS assessments obtained outside of the allowable timeframe will not be
included in measure calculation.
If more than one postoperative OKS was obtained during the nine to 20 weeks
following the procedure, use the most recent score obtained during the allowable
timeframe.
Leave BLANK if a postoperative OKS was not obtained.

Quality Check: If a date is entered, verify dates are valid.

AR

3 Mon Postop
OKS Score

Enter the three-month postoperative OKS summary score.
•
•
•

Only include scores for patients who have answered ALL questions, do not submit
scores for partially completed tools.
If the patient selects more than one response for a single question, select the worst
(lower numeric value) response to calculate the summary score.
Leave BLANK if a complete and valid postoperative OKS was not obtained.

Quality Check: If data is entered, verify that each cell has a value between zero and 48.
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Data Collection
Column
AS

Field Name
3 Mon Postop
PGH Date

Notes
Enter the date on which the three-month postoperative PROMIS-10 was
completed by the patient.
•

•

•

The allowable date range for the three-month assessment is nine to 20 weeks after
the procedure date.
o PROMIS-10 results obtained outside of the allowable timeframe will not be
included in measure calculation.
If more than one postoperative PROMIS-10 was obtained during the nine to 20
weeks following the procedure, use the most recent result obtained during the
allowable timeframe.
Leave BLANK if a postoperative PROMIS-10 was not obtained.

Excel Format

Example

Date
(mm/dd/yyyy)

2/9/2018

Number,
Whole
numbers only

3

Quality Check: If a date is entered, verify dates are valid.

AT

3 Mon Postop
PGH 1 Health

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general health rating.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

AU

3 Mon Postop
PGH 2 Quality

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general quality of life.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

AV

3 Mon Postop
PGH 3 Physical

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general physical health.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

AW

3 Mon Postop
PGH 4 Mental

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general mental health.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

AX

3 Mon Postop
PGH 5 Satis
Social

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general satisfaction with social activities
and relationships.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

AY

3 Mon Postop
PGH 9 Soc
Activities

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding ability to carry out social activities and
roles.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

AZ

3 Mon Postop
PGH 6 Phys
Activities

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding ability to carry out physical activities.
1 = Not at all
2 = A little
3 = Moderately
4 = Mostly
5 = Completely
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

BA

3 Mon Postop
PGH 10
Emotional

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding emotional problems in the past seven days.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Never
2 = Rarely
3 = Sometimes
4 = Often
5 = Always
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

BB

3 Mon Postop
PGH 8 Fatigue

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding fatigue on average in the past seven days.
1 = None
2 = Mild
3 = Moderate
4 = Severe
5 = Very Severe
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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Data Collection
Column

Field Name

Notes

Excel Format

Example

BC

3 Mon Postop
PGH 7 Pain

Enter the value of the patient’s postoperative response to the PROMIS-10
question regarding pain rating in the last seven days using a scale of zero (No
Pain) to ten (Worst imaginable pain).

Number,
Whole
numbers only

3

Date
(mm/dd/yyyy)

12/13/2018

Number;
Whole
numbers only

42

Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero and ten.

BD

1 Yr Postop OKS
Date

Enter the date on which the one-year postoperative OKS was completed by the
patient.
•

•

•

The allowable date range for the one-year assessment is nine to 15 months after the
procedure date.
o OKS assessments obtained outside of the allowable timeframe will not be
included in measure calculation.
If more than one postoperative OKS was obtained during the nine to 15 months
following the procedure, use the most recent score obtained during the allowable
timeframe.
Leave BLANK if a postoperative OKS was not obtained.

Quality Check: If a date is entered, verify dates are valid.

BE

1 Yr Postop OKS
Score

Enter the one-year postoperative OKS summary score.
•
•
•

Only include scores for patients who have answered ALL questions, do not submit
scores for partially completed tools.
If the patient selects more than one response for a single question, select the worst
(lower numeric value) response to calculate the summary score.
Leave BLANK if a complete and valid postoperative OKS was not obtained.

Quality Check: If data is entered, verify that the score is between zero and 48.
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Data Collection
Column
BF

Field Name
1 Yr Postop PGH
Date

Notes
Enter the date on which the one-year postoperative PROMIS-10 was
completed by the patient.
•

•

•

The allowable date range for the one-year assessment is nine to 15 months after the
procedure date.
o PROMIS-10 results obtained outside of the allowable timeframe will not be
included in measure calculation.
If more than one postoperative PROMIS-10 was obtained during the nine to 15
months following the procedure, use the most recent result obtained during the
allowable timeframe.
Leave BLANK if a postoperative PROMIS-10 was not obtained.

Excel Format

Example

Date
(mm/dd/yyyy)

12/13/2018

Number,
Whole
numbers only

3

Quality Check: If a date is entered, verify dates are valid.

BG

1 Yr Postop PGH
1 Health

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general health rating.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

BH

1 Yr Postop PGH
2 Quality

Notes
Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general quality of life.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent

Excel Format

Example

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

BI

1 Yr Postop PGH
3 Physical

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general physical health.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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Data Collection
Column

Field Name

Notes

Excel Format

Example

BJ

1 Yr Postop PGH
4 Mental

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general mental health.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

BK

1 Yr Postop PGH
5 Satis Social

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general satisfaction with social activities
and relationships.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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Data Collection
Column

Field Name

Notes

Excel Format

Example

BL

1 Yr Postop PGH
9 Soc Activities

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding ability to carry out social activities and
roles.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

BM

1 Yr Postop PGH
6 Phys Activities

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding ability to carry out physical activities.
1 = Not at all
2 = A little
3 = Moderately
4 = Mostly
5 = Completely
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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Data Collection
Column

Field Name

Notes

Excel Format

Example

BN

1 Yr Postop PGH
10 Emotional

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding emotional problems in the past seven days.

Number,
Whole
numbers only

3

Number,
Whole
numbers only

3

1 = Never
2 = Rarely
3 = Sometimes
4 = Often
5 = Always
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.

BO

1 Yr Postop PGH
8 Fatigue

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding fatigue on average in the past seven days.
1 = None
2 = Mild
3 = Moderate
4 = Severe
5 = Very Severe
Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one and five.
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2019 Total Knee Replacement
Data Collection
Column

Field Name

Notes

Excel Format

Example

BP

1 Yr Postop PGH
7 Pain

Enter the value of the patient’s postoperative response to the PROMIS-10
question regarding pain rating using a scale of zero (No Pain) to ten (Worst
imaginable pain).

Number,
Whole
numbers only

3

Leave BLANK if the patient did not answer the question, if the patient selected more
than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero and ten.
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C. Data Quality Checks
MNCM recommends that medical groups complete several quality checks of the data prior to file
upload. Quality checks improve data accuracy, reduce the likelihood of errors, and ensure that the data
can be successfully validated upon audit.
Quality Check 1: File Check
Use Excel’s AutoFilter feature to complete data quality checks of specific data elements in the Excel file.
To set the filter and review specific data elements:
1. Click inside any data cell and activate the AutoFilter by:
a. In Excel 2003, click the Data menu, point to Filter, and then click AutoFilter.
b. In more recent versions of Excel, click the Data tab and in the Sort & Filter area click
Filter.
2. Click on the drop-down boxes of any column and scan for key entry errors, “out-of-range” or
missing data and determine if the data needs to be corrected.
Quality Check 2: Verify Clinical Data
Verify the collected clinical data by reviewing a small sample of records (eight to ten) to compare with
the documentation within the patients’ medical records. If errors are identified, make the corrections in
the data file. Also consider whether the errors were isolated or indicative of a larger data collection
problem.
Quality Check 3: General
Complete the general quality checks outlined below:
1. Complete the quality checks listed in the Notes section of each data element in the Data
Elements and Field Specifications table.
2. Verify that all fields intended to be left blank are indeed blank. Do NOT enter hyphens or zeroes.
3. Remove blank rows at the bottom of the Excel spreadsheet.
a. Press Ctrl/End to go to the bottom-most cell in the spreadsheet. If there are blank rows,
highlight them, right-click in the left margin, and select Delete.
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Section III: Data Submission
A. Data File Creation
Before proceeding with the file submission, be sure to:
• Complete all data collection and data entry.
• Complete data quality checks.
• Combine all clinic files onto one spreadsheet. All clinics in a medical group must be uploaded in
one, single file. The clinic identifier is the Clinic ID.
• Verify that each column is formatted according to measure specifications (TEXT, NUMBER, or
DATE formatting). Columns can be any width.
• Verify that all original columns remain in the spreadsheet even if there is no data in a column.
Do NOT delete any columns.
Once the above steps are completed:
1. Save the Excel template.
2. Save the file in CSV format.
a. The CSV file will be the data file uploaded to the MNCM Data Portal.
How to create a CSV file from an Excel file:
For Excel 2003 Users
1.
2.
3.

4.
5.
6.
7.
8.

For Excel 2007 Users

For Users of more recent versions
of Excel

Open the original Excel file (.xls).
Activate the worksheet to be uploaded by clicking the worksheet tab.
Click File, Save As.
3. Click the Office Button
3. Click the File tab (upper left(upper left-hand corner of
hand corner of screen);
screen); select Save As.
select Save As.
Navigate to the folder where the file will be saved.
Enter the file name.
At the bottom of the Save As dialog box, choose CSV (comma delimited) from the Save as type
drop-down.
Click Save. The following warning will appear: “…may contain features that are not compatible with
CSV. Do you want to keep the workbook in this format?” Click Yes.
Close the file. A message will appear: “Do you want to save this file...?” Click Yes or No.

NOTE: If corrections to the data are needed after the CSV file has been created; do NOT open the CSV
file in Excel to make these corrections. Doing so alters the data. To make changes, follow these steps:
1. Open the original Excel template.
2. Make changes in the Excel template.
3. Save the Excel template.
4. Save the file with the changes as a new CSV file.
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B. Data Submission
Click Data Submission on the Home tab in the MNCM Data Portal under the Total Knee Replacement section. Use the following steps to submit
data to MNCM.
Step 1: Enter Denominator
Using the instructions below, manually enter denominator counts and information or complete and upload a file with this information. Whether
done manually or via a file upload, the information must be completed for each clinic row.
For file upload, begin by clicking Download the Denominator Worksheet. Then follow the steps in the table below to complete the worksheet.
Denominator Entry Field Specifications
Field Name

Denominator Worksheet

Manual Entry

Method Used for
Data Collection

Column C
Enter the code applicable to the
clinic:

Make selection applicable to the clinic
from drop-down menu:

REL Data Collection

1 = EMR: All data pulled via query
2 = Manual: Paper records only
3 = Manual: EMR and paper record
4 = EMR: Some data looked up
manually
5 = EMR: All data looked up manually
Columns D - G
Enter the appropriate code for each
category:
1 = Yes, this clinic utilizes best
practice
0 = No, this clinic does not utilize best
practice

•
•
•
•
•

Notes

EMR: All data pulled via query
Manual: Paper records only
Manual: EMR and paper record
EMR: Some data looked up
manually
EMR: All data looked up manually

Check the box under each category for
which best practices were utilized in
the collection of REL data at the clinic.

Best practice methods include:
•
Race: Self-Report: Allowing patient to self-report their race and/or
Hispanic ethnicity
•
Race: Reporting Multiple Races: NOT using a multi-racial category,
allowing patients to select more than one race AND using a system that
allows the collection and reporting of more than one race for each
patient
•
Language: Self-Report: Allowing patient to self-report preferred language
•
Country: Self-Report: Allowing patient to self-report country of origin

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
32

2019 Total Knee Replacement
Data Submission
Field Name

Denominator Worksheet

Manual Entry

Notes

Not Reporting

Column H and I
Enter the appropriate code in column
H:

Check this box if the clinic is not
reporting any data for this cycle of
data collection

•

0 = Clinic is reporting
1 = Clinic is NOT reporting
Column I
Enter a reason for not reporting (e.g.
no patients meet eligibility criteria

Please be advised that MNCM’s policy requires ALL clinic sites within a
medical group to submit their data through the DDS process. Likewise,
this is a condition of participation in pay-for-performance programs.

Enter reason for not reporting in text
box provided (e.g. no patients meet
eligibility criteria)

If completing the Enter Denominator step via file upload, save the completed file in CSV format (see Section III - A for more information). Click
Browse or Choose File to locate the file and then click Submit File.
Once the information is populated, click on Save and Continue.
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Step 2: Review & Save
Verify the data entered by reviewing all of the clinic site’s information for accuracy. Click Save and
Continue or click Back to Step 1 to correct the information.
Step 3: Upload Data
Click Browse or Choose File to search for the CSV file (Figure 1-A) and click Upload CSV and Continue
(Figure 1-B).

A

B

Figure 1
The MNCM Data Portal will scan the CSV file to identify possible errors. The Data Portal will then provide
an upload status that will indicate if there are errors or warnings in the data file. Click on the Refresh link
to view an updated upload status (Figure 2).

Figure 2
To view errors and warnings, click View Errors & Warnings (Figure 3-A).
•

Errors: Corrections must be made and a corrected file uploaded (e.g., date of birth is out-ofrange). Refer to the Data Elements and Field Specifications to review the required data
specifications for each column.
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o

Make corrections in the original Excel file and save the corrected file. Then save as a new
CSV file to upload. Do NOT make corrections in the CSV file as this will alter the data.

o

To re-enter the data collection method and/or REL Best Practice status and upload the
corrected file starting from Step 1: Enter Denominator click Clear & Start Over (Figure 3-B).
▪

o
•

Completion of Steps 1, 2 and 3 will be necessary if Clear & Start Over is clicked.

If corrections are only needed to the data file click Re-Upload Data (csv) file (Figure 3-C).
Begin with Step 3: Upload Data.

Warnings: Closely review these possible errors and decide whether corrections are needed. If
corrections to the data file are necessary, refer to instructions above. If corrections are not
necessary, click Continue to Step 4 (Figure 3-D).

Once the Data (CSV) File has been successfully uploaded to the Data Portal, click Continue to Step 4
(Figure 3-D).

B

Figure 3
Step 4: Review & Submit
1. Review the quality checks for each item listed in the Data Elements and Field Specifications table as
well as the preliminary results and their comparison to the previous measure period’s results to
determine if there are errors in the data.
• To resubmit the data file only, click Re-Upload Data (CSV) File.
• To resubmit the data collection method and/or REL Best Practice status and the data file, click
Clear & Start Over at the bottom of the page.
Again, make corrections in the original Excel file and save the corrected file with a new name.
Then save as a new CSV file to upload. Do NOT make corrections in the CSV file as this will alter the
data.
2. Complete the Data Comparison Notes. This is a required field.
NOTE: If this is the first data submission for this measure or if there have been substantial changes
to the measure itself, there will be no table showing comparison of population and rates to a
previous submission and the Data Comparison Notes text box will not display.
Review and compare the results (population and rates) to the prior submission:
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•
•

Number of Procedures Performed – The number of procedures included in the current and
previous submission.
Rates – Measure results for the current and previous submission.

Using the text box provided, describe reasons for any substantial changes in population or results
from the previous submission. Comments in this field inform MNCM about reasons for the changes
and avoids additional follow-up. After the text box is completed, click Save Notes.
• To complete this step later, click Save as Draft. To access the submission again, click on Data
Submission under the Total Knee Replacement section on the Home tab. Contact
support@mncm.org for assistance.
3. When the data is ready to submit to MNCM click Submit Data to MNCM.
• The Submit Data to MNCM button will not appear until the Data Comparison Notes step has
been completed as stated above.
Step 5: Done
The data file has been successfully submitted. The MNCM Data Portal will generate an e-mail confirming
receipt.
To download a report of patient level numerator compliance information, click Download Data near the
top of the data comparison section. Columns on the far right of the report indicate the patient’s change
in assessment scores between their preoperative and postoperative evaluations.
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Section IV: Data Validation
After data is submitted, MNCM completes the following validation of the preliminary results to ensure
accuracy and comparability.
Quality Checks
MNCM completes quality checks of the submitted data. If errors are identified, the medical group must
make corrections to the data file and resubmit.
Validation Audit
All medical groups are subject to an audit. Medical groups selected for an audit are contacted by MNCM.
A list of records for audit will be provided and posted onto the Home page of the Data Portal for the
medical group. Other audit preparations:
• The medical group or clinic site representative must be available to participate in the entire
audit process.
o For data that resides in an electronic record, the audit will be conducted via a HIPAA
secure, online meeting service; the medical group or clinic representative will need to
retrieve and display the selected records and screens necessary to complete the audit.
o For data that resides in a paper record, the audit will take place onsite.
• Patient names or other personal information may be blinded. MNCM will verify date of birth.
• The following items must be available for the audit:
o ALL requested patient records.
o The “crosswalk” between the unique patient identifier and the patient’s name and date
of birth, as necessary.
o Data collection forms and other notes describing where various data elements were
located in the patient record.
o List of patients that were excluded.
NCQA 8 and 30 Audit Process
MNCM utilizes the National Committee for Quality Assurance (NCQA) “8 and 30” process for audits.
• MNCM randomly selects 33 records from each applicable clinic site for validation. At most, 30
records for each clinic site will be reviewed. The additional three records are oversamples to
ensure 30 records will be available on the day of the review.
• The MNCM auditor reviews records one through eight in the sample to verify whether the
submitted data matches the source data in the medical record.
• If no errors are found in these eight records, the compliance rate is 100 percent, and the clinic
site is determined to be in high compliance. The MNCM auditor may determine no further
record review is necessary. The MNCM auditor communicates results to MNCM staff.
• If the auditor identifies one or more errors in these eight records, the auditor will continue
auditing records nine through 30 and a compliance rate is calculated (e.g., 27/30 records
compliant, 90 percent). If the compliance rate is less than 90 percent, the auditor will
communicate the results with MNCM, who will contact the medical group to discuss a corrective
action.
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Two-Week Medical Group Review of the Preliminary Statewide Results
The two-week medical group review is the medical group’s official opportunity to review and comment
on the preliminary statewide results. MNCM will provide a file of the results to all participating medical
groups. Each medical group is responsible for reviewing their own results, investigating any concerns,
and submitting evidence to MNCM if a change in results is requested. MNCM staff will review all
requests and determine an appropriate course of action. A notification about this review will be sent to
the primary data contact and other key contacts registered by the medical group in the MNCM Data
Portal.
After Validation
After MNCM validation is completed, MNCM will approve the data in the MNCM Data Portal. An e-mail
will be sent to the medical group’s data contact notifying them that the data was approved.
After all statewide results are approved, MNCM may publish clinic and medical group level results on
MNHealthScores.org. Results can also be found on the MNCM Data Portal > Results tab.
Medical groups should maintain data submission files and other documents related to data submission
for two years.
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Appendix A: About Direct Data Submission
The goal of Direct Data Submission (DDS) is to collect patient-level data from medical groups on specific health
care conditions and publicly report comparable results of health care quality at the clinic site and/or medical
group level. All medical groups follow the same instructions for eligible population identification and data
collection. MNCM certifies methodologies prior to data collection. Then each medical group submits data to
MNCM via a secure, online data portal. As an independent auditor and as a service to each medical group,
MNCM validates the data for accuracy, calculates results from the validated data, and publicly reports the data
on MNHealthScores.org.

Required Reporting
DDS fulfills participation requirements for the Minnesota Department of Health’s Minnesota Statewide Quality
Reporting and Measurement System (SQRMS) as well as other health plan pay-for-performance programs. In
addition, DDS results can be used by medical groups for quality improvement purposes.

DDS Terms and Conditions
To participate in the DDS process, medical groups must agree to:
• MNCM’s DDS Terms and Conditions (signed electronically on the MNCM Data Portal).
• Complete a Business Associate Agreement with MNCM (signed electronically on the MNCM Data Portal).
• Submit a patient-level file to the secure MNCM Data Portal that automatically calculates results.
• Participate in the data validation process as required by MNCM.
• Have results publicly reported on MNHealthScores.org and in other reports.
• Submit data for ALL clinic sites.
• Submit data in required format (CSV).
• Submit data in good faith.
• Adhere to and follow all data submission timelines and formatting specifications.
Medical groups also understand that:
• MNCM works with corresponding health plans to determine Primary payer type (Commercial/Private,
Medicaid, Medicare, uninsured/self/pay) on your behalf to reduce burden.
• Most Minnesota health plans only accept results generated from the DDS method for their incentive
programs, because the patient-level results can be validated.

Compliance with Federal and State Regulations
Our legal counsel has assured us that the DDS method complies with applicable provisions of the Health
Insurance Portability and Accountability Act (HIPAA), Health Information Technology for Economic and Clinical
Health (HITECH) Act, and Minnesota statute as long as we are acting as a business associate to each participating
medical group (e.g., by gathering and submitting data on its behalf) and have a signed BAA with the medical
group. The BAA is signed electronically on the MNCM Data Portal. The BAA is signed once and remains in effect
for all DDS measures.
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Health Insurance Portability and Accountability Act Law:
•

The activities of data collection, data submission, public reporting and use of results for quality
improvement are considered within the scope of health care operations associated with the medical
group quality improvement efforts.

•

The federal HIPAA law specifically allows release of individually identifiable health information - without
the consent or authorization of the individual - for treatment, payment and health care operations of, or
for, the provider.

•

MNCM’s business associate agreement includes all provisions required by the HITECH Act.

Minnesota Statute:
•

The primary governing Minnesota statute is MN Stat. Section 144.335.

•

Subd. 3a. entitled "Patient consent to release of records; liability" states: (a) A provider, or a person who
receives health records from a provider, may not release a patient's health records to a person without
a signed and dated consent from the patient or the patient's legally authorized representative
authorizing the release, unless the release is specifically authorized by law.

•

However, the statute does not restrict release (without patient authorization) to only those
circumstances authorized by state law – the statute also applies to a release authorized by federal law.

•

Legal counsel assures us that it is reasonable to conclude that the HIPAA privacy regulation does
specifically authorize the release of such information. A covered entity is authorized by HIPAA to release
patient information for, among other things, health care operations and to its business associate that is
providing such health care operations on its behalf. As stated above, the services MNCM is engaged in
with providers falls within the scope of health care operations, and MNCM is acting as a business
associate to the medical groups when performing the services discussed above.
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Appendix B: Facility Codes
The tables below only include facilities within the state of Minnesota. The tables are not all inclusive. If the hospital or
freestanding outpatient surgical center where the procedure was performed does not have an ID number assigned below,
enter a code of “999” for Other and complete the free text field Facility Other Description.

Table 1: Hospital Facility Codes
51
234
206
172
201
104
211
213
565
276
281
294
110
149
159
134
136
140
38
217
224
229
231
117
237
203
225
290
246
261
175
124
142
148
167
147
186
241
285
44
41
267
42
250
251

Abbott Northwestern Hospital
Alomere Health
Appleton Area Health Services
Avera Marshall Regional Medical Center
Avera Tyler Hospital
Bigfork Valley Hospital
Buffalo Hospital
Cambridge Medical Center
Cass Lake IHS Hospital
CentraCare Health - Long Prairie
CentraCare Health - Melrose
CentraCare Health - Monticello
CentraCare Health - Paynesville
CentraCare Health - Sauk Centre
CHI LakeWood Health Center
CHI St. Francis Health
CHI St. Gabriel's Hospital
CHI St. Joseph's Health
Children's Minnesota
Chippewa County-Montevideo Hospital
Community Memorial Hospital
Cook Hospital & Care Center
Cuyuna Regional Medical Center
District One Hospital
Ely Bloomenson Community Hospital
Essentia Health - Ada
Essentia Health - Deer River
Essentia Health - Duluth (Miller-Dwan Building)
Essentia Health - Fosston
Essentia Health - Holy Trinity Hospital (Graceville)
Essentia Health - Northern Pines (Aurora)
Essentia Health - Sandstone
Essentia Health - St. Joseph's Medical Center (Brainerd)
Essentia Health - St. Mary's Medical Center (Duluth)
Essentia Health - Virginia
Essentia Health St. Mary's - Detroit Lakes
Fairview Lakes Medical Center
Fairview Northland Medical Center
Fairview Range
Fairview Ridges Hospital
Fairview Southdale Hospital
FirstLight Health System
Gillette Children's Specialty Healthcare
Glacial Ridge Health System
Glencoe Regional Health Services

264
253
22
258
262
266
269
271
272
3
161
121
277
278
279
32
100
215
239
270
561
114
138
130
171
170
145

Grand Itasca Clinic and Hospital
Granite Falls Health Hospital
HCMC
Hendricks Community Hospital Association
Hutchinson Health Hospital
Johnson Memorial Health Services
Kittson Memorial Healthcare Center
Lake Region Healthcare
Lake View Hospital
Lakeview Hospital
Lakewood Health System
LifeCare Medical Center
Madelia Community Hospital & Clinic
Madison Hospital
Mahnomen Health Center
Maple Grove Hospital
Mayo Clinic Health System in Albert Lea & Austin
Mayo Clinic Health System in Cannon Falls
Mayo Clinic Health System in Fairmont
Mayo Clinic Health System in Lake City
Mayo Clinic Health System in Mankato
Mayo Clinic Health System in New Prague
Mayo Clinic Health System in Red Wing
Mayo Clinic Health System in Springfield
Mayo Clinic Health System in St. James
Mayo Clinic Health System in Waseca
Mayo Clinic Hospital - Saint Mary's Campus and
Methodist Campus
280 Meeker Memorial Hospital
2
Mercy Hospital (Coon Rapids & Unity Campus)
283 Mercy Hospital (Moose Lake)
26 Methodist Hospital
228 Mille Lacs Health System
24003F Minneapolis VA Health Care System
299 Murray County Medical Center
127 New Ulm Medical Center
30 North Memorial Health Hospital
230 North Shore Health
169 North Valley Health Center
105 Northfield Hospital
107 Olmsted Medical Center
108 Ortonville Area Health Services
257 Owatonna Hospital
112 Perham Health
33 Phillips Eye Institute
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113 Pipestone County Medical Center Avera
254 Prairie Ridge Hospital and Health Services
245 Rainy Lake Medical Center
116 RC Hospital & Clinics
240206 Red Lake IHS Hospital
296 Redwood Area Hospital
12 Regina Hospital
11 Regions Hospital
118 Rice Memorial Hospital
292 Ridgeview Le Sueur Medical Center
6
Ridgeview Medical Center
207 Ridgeview Sibley Medical Center
222 River's Edge Hospital & Clinic
119 RiverView Health
204 Riverwood Healthcare Center
133 Saint Elizabeth's Medical Center
219 Sanford Bagley Medical Center
102 Sanford Bemidji Medical Center
214 Sanford Canby Medical Center
265 Sanford Jackson Medical Center
221 Sanford Luverne Medical Center
106 Sanford Thief River Falls Medical Center

156 Sanford Tracy Medical Center
235 Sanford Westbrook Medical Center
174 Sanford Wheaton Medical Center
177 Sanford Worthington Medical Center
8
Shriners Hospitals for Children - Twin Cities
129 Sleepy Eye Medical Center
367 St. Cloud Hospital
24002F St. Cloud VA Health Care System
7
St. Francis Regional Medical Center
21 St. John's Hospital
13 St. Joseph's Hospital
143 St. Luke's Hospital
152 Stevens Community Medical Center
153 Swift County-Benson Health Services
157 Tri-County Health Care
52 United Hospital
162 United Hospital District
19 University of Minnesota Medical Center - East Bank
Campus and West Bank Campus
176 Windom Area Hospital
227 Winona Health
14 Woodwinds Health Campus

Table 2: Freestanding Outpatient Surgical Centers
64
48
18
6
11
31
49
9
17
19
52
54
69
3
22
7
13
10
43

Allina Health - WestHealth Surgery Center
Ambulatory Surgery Center - Midsota Surgical Suites
Brainerd Lakes Surgery Center
Carris Health Surgery Center - Willmar
Centennial Lakes Surgery Center
CentraCare Surgery Center
Chu Surgery Center
Crossroads Surgery Center
Crosstown Surgery Center
Edina Surgery Center, Inc
Fairview Maple Grove Surgery Center
Family Surgery Center LLC
Greenway Surgery Center
High Pointe Surgery Center
Institute for Low Back and Neck Care, Special
Procedures
Lakewood Surgery Center
Landmark Surgery Center
Mankato Surgery Center
Maplewood Surgery Center

47
41
40
42
38
4
29
32
67
39
15
62
26
23
70
71
50
30

Midwest Surgery Center
Minneapolis Pain Centers - Edina
Minneapolis Pain Centers - Maple Grove
Minnesota Orthopaedic Surgery Center LLC
Minnesota Valley Surgery Center, LLC
North Memorial Ambulatory Surgery Center at Maple
Grove
North Metro Surgery Center
Orthopaedic Institute Surgery Center
Pain Centers of Minnesota-Mankato
Pavilion Surgery Center, LLC
Saint Cloud Surgical Center
Sanford Health Detroit Lakes Clinic Same Day Surgery
Center
South Central Surgical Center
Southwest Minnesota Surgical Center, Inc.
Summit Orthopedics - Plymouth Surgery Center
Summit Orthopedics - Vadnais Heights Surgery Center
TC CDI ASC
TRIA Orthopaedic Center, LLC
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Appendix C: Patient Reported Outcome (PRO) Tools
The most important step in measuring the change in functional status and quality of life for patients is to
implement the administration of the PRO tools into the clinic’s processes and work flows. PRO tools
need to be integrated into the preoperative evaluation and postoperative follow-up at three months
and one year. There are two PRO tools used to calculate the outcomes for the patient:
•
•

Oxford Knee Score, a knee specific functional status assessment tool
PROMIS Global Health 10, a quality of life assessment tool.

Additional Information about PRO Tools
•
•

Ideally, tools are completed by the patient at the time of the preoperative and postoperative
visits; however, office visits are not required for tool completion. Any provider or office staff
may administer the pre and postoperative assessment tools.
Regardless of mode of administration, the content of all tools must be kept intact including
question text, order and scoring. Altering the tool from its original form affects its psychometric
properties as tested and invalidates the tool. Do not submit scores from invalid tools.

PRO Patient Reported Outcome Tools- Modes of acceptable administration
Administration Mode
OKS
PROMIS-10
In person/during visit
Acceptable
Acceptable
Via mail
Acceptable
Acceptable
Via telephone
Not Acceptable*
Acceptable
Administer electronically **
Acceptable+
Acceptable
*Tools have not been validated for phone administration and/ or visual analog components would be
difficult to replicate by phone interview.
**When administering electronically, the tool must be kept intact including content, order and scoring.
Electronic examples: Email, patient portal, iPad/tablet, patient kiosk.
+
Review and approval of electronic adaptation of the OKS created by a medical group is required by Isis
Innovation, Inc., the tool copyright holder. Guidelines for ePRO adaptation of this tool can be found on
the Resources tab in the Data Portal.
Other Activities
OKS
PROMIS-10
Store results in EMR
Acceptable
Acceptable
Must seek approval for other uses*
Yes
Yes
* examples: research, publication, use of tool beyond measure population, etc.
NOTE: All patients who meet eligible population criteria must be included in the data submission file,
whether or not they completed the Patient Reported Outcome tools.
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Oxford Knee Score (OKS)
This is a patient completed survey consisting of twelve structured questions asking the patient to
describe the impact of their knee function in the following areas: level of pain, self-care, getting in and
out of a car, length of time able to walk, sitting, kneeling, night pain, interference with usual work,
limping and ability to climb or descend stairs. More information can be found at:
http://innovation.ox.ac.uk/outcome-measures/oxford-knee-score-oks/
The OKS functional status assessment is submitted as the summary score only. The valid range of
summary scores is 0 to 48; a score of 48 reflects the best possible knee function.
•

Only submit scores when the patient has answered all 12 questions.
o Do not submit a score for a patient when the tool is only partially completed.
Incomplete tools make the functional status appear worse than it really is as a lower
number indicates increased severity of symptoms.

•

If the patient selects more than one response for a single question, select the worst (most
severe) response and use to calculate the summary score.
o Do not assume that the higher numeric value is the “worst” score for this tool. The
tool is scaled with numeric ratings where a higher number is better function and the
lower number is worse function.

References
Dawson J, Fitzpatrick R, Murray D, Carr A. Questionnaire on the perceptions of patients about total knee
replacement. J Bone Joint Surg Br. 1998 Jan; 80(1):63-9
Murray D.W., Fitzpatrick R., Rogers K., Pandit H., Beard D., Carr A.J., Dawson J. The use of the Oxford hip
and knee scores. J. Bone Joint Surg. [Br] 2007; 89-B:1010-14

Permissions
The OKS tool was developed by Professor Ray Fitzpatrick and Dr. Jill Dawson at Oxford University.
The OKS document in use in the clinics must specify the following copyright language:
© Oxford University Innovation Limited, 1998. All rights reserved. Oxford Knee Score – English for the
United States.
Permission was granted to MNCM for the use of the OKS in individual clinical practice for the purposes
of participating in MNCM’s data submission and reporting of functional status outcome measures. If
any group or clinic plans to use results from the OKS tool for other purposes (i.e., research study and
publication), additional licensure will need to be obtained from Oxford University Innovation Ltd to
avoid copyright infringement. The OKS tool is located on the Data Portal under the Resources Tab/ Total
Knee Replacement Resources/ Functional Status Tools at https://data.mncm.org/
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PROMIS Global Health ‐ 10
PROMIS Global Health – 10 is a patient completed assessment of health-related quality of life and
consists of 10 structured questions reported on two subscales – general physical health and general
mental health. The NIH-sponsored tool is publicly available, free of charge and has multiple modes of
administration available.
In using the PROMIS-10 for reporting outcomes, it is strongly recommended by the developer of the tool
that:
1. A summary score is not used and that the results are reported by its two subscales, reflecting
global physical health and global mental health; and
2. The metric used for comparison is conversion to a T-score and reported as a change in T-score.
T-Score distributions are standardized such that a 50 represents the average (mean) for the US
general population, and the standard deviation around that mean is 10 points. A high score
always represents more of the concept being measured. Thus, a person who has T-scores of 60
for the Global Physical Health or Global Mental Health scales is one standard deviation better
(healthier) than the general population.
For more information, access the PROMIS website: http://www.nihpromis.org/default.
Given the need to correctly calculate outcomes for the subscale measures and convert the results to the
appropriate T-score metric, medical groups must submit the corresponding number to each of the
patient’s response for all questions.
•

If the patient selects more than one response for a PROMIS-10 question; submit a blank for the
value for that question.

Versions of the PROMIS Global Health-10 (PROMIS-10)
MNCM has a license agreement with PROMIS Health Organization (PHO) to provide a PDF version of the
tool to providers on the MNCM data portal. On an annual basis, MNCM reviews the PHO website to
determine if there has been a version change. Version v1.1 is the version that has been in place since
the 2013 transition to PROMIS-10. In August 2016, a minor version v1.2 was published. PHO indicates
that a decimal change in a version reflects only a minor change, and this is the case for v1.2. The only
changes in this version upgrade were related to the numeric scaling of questions 8 and 10. There were
no changes in the context, wording of questions or order of questions. Granted, this changing of the
numeric scale removes the need for conversion of responses for Q8 and Q10 to allow for scoring, but
the MNCM Data Portal already does this conversion on file upload. It would be disruptive and
burdensome to practices to implement a new tool based on this minor change that does not impact the
psychometric properties of the tool. MNCM has decided to postpone upgrading to a new version of the
tool until there are substantial changes (e.g. wording of questions or contextual instructions for the
patient) that threaten comparability.
Note: Review of PROMIS Global Health instruments in August 2018 demonstrate no additional version
and therefore no needed change related to version.
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Therefore, medical groups should continue to utilize PROMIS-10 v1.1, available on the MNCM Data
Portal Resources Tab, until further notice.
In the future, with a substantive change in tool that necessitates a new version, medical groups will
receive advanced notice of a version change and the tool will be provided on the MNCM Data Portal.

References
Hays, R. D., Bjorner, J. B., Revicki, D. A., Spritzer, K. L., & Cella, D. (2009). Development of physical and
mental health summary scores from the patient-reported outcomes measurement information system
(PROMIS) global items. Quality of Life Research, 18(7), 873-880.
http://www.nihpromis.org/

Permissions
Permission was granted to MNCM for the use of the PROMIS Global Health- 10 in individual clinical
practice for the purposes of participating in the state-wide quality reporting and improvement effort. If
any medical group or practice plan to use results from the PROMIS-10 tool for other purposes or other
populations (i.e., research study and publication), it is recommended that an additional user agreement
with PROMIS Health Organization be obtained by the medical group that outlines its planned use.
Request form for instruments can be obtained at www.nihpromis.org/measures/instrumentdetails
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Appendix D: Additional Measures
The following is a list of measures that will be calculated based on the data file submission of patients
meeting inclusion criteria. No additional calculations or submissions are required from the medical
groups.
MNCM
Measure
Additional
Measures

Total Knee Replacement (TKR) Direct Data Submission Measures
Outcome measures will provide information about functional status and quality of life
improvements following TKR procedures. The three-month postoperative functional status
measures were selected to demonstrate potential variation in provider technique and
postoperative rehabilitation (important to providers), whereas the measure at one year
reflects the functional status that can be achieved (important to patients).
Process measures provide an understanding about a medical group’s/clinic’s adoption of
the functional status tools.
Additional Outcome Measures Include:
• Average postoperative functional status improvement at three months
postoperatively for patients undergoing TKR as measured by the Oxford Knee Score
tool.
• Average postoperative quality of life improvement at three months postoperatively
for patients undergoing TKR as measured by the PROMIS-10 tool.
Additional Process Measures Include:
The percentage of TKR patients who have a preop, three month and one-year assessment
of functional status with the Oxford Knee Score and PROMIS-10 quality of life score.
• Number of TKR procedures performed during the measurement period
• Number and % of TKR patients administered a preop Oxford Knee Score (within 3
months of proc)
• Number and % of TKR patients administered a preop PROMIS-10 (within 3 months of
procedure)
• Number and % of TKR patients administered a three-month postoperative Oxford
Knee Score
• Number and % of TKR patients administered a one-year postoperative Oxford Knee
Score
• Number and % of TKR patients administered a three-month postoperative PROMIS-10
• Number and % of TKR patients administered a one-year postoperative PROMIS-10
• Number and % of TKR patients administered both a preoperative and one-year
postoperative Oxford Knee Score
• Number and % of TKR patients administered both a preoperative and one-year
postoperative PROMIS-10
• Number and % of TKR patients administered both a preoperative and three-month
postoperative Oxford Knee Score
• Number and % of TKR patients administered both a preoperative and three-month
postoperative PROMIS-10
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Appendix E: Glossary of Terms
Standard list of terms often used in the data submission process. Not all terms apply to all measures.
Allowable Exclusions: Allowable exclusions are optional. A medical group may choose to remove
patients from data submission who meet the criteria described in the Allowable Exclusions section of
the measure specifications.
Assignment: The process by which clinics are assigned to clinical quality measures, for which they are
then responsible to report data to MNCM. Assignments are based on specialties offered at each clinic.
These specialties are selected by the medical group during clinic registration.
Audit: The process by which MNCM reviews and validates the data submitted to ensure the data reflects
the patient record. Audits are completed on-site at a clinic or electronically.
Calculated Exclusions: Exclusions that are calculated by the MNCM Data Portal based on data supplied
in the data file. Patients to whom a calculated exclusion applies must still be included in the data file;
upon submission, the Data Portal will remove the appropriate patients from measure calculation.
Clinic: The individual practice site or sites that are registered under the main medical group. Clinics are
locations where primary or specialty care ambulatory services are provided for a fee by one or more
physicians.
A clinic site location is a building, separate space or an entity with a street address. It should be a
functional unit that is easily understood by patients/consumers. The goal of reporting by clinic site is to
provide patients/consumers with information about the entity with which they are most familiar and to
provide information to clinics that is actionable for quality improvement purposes.
Clinic and Provider Registration: The annual process by which clinics and providers register on the
MNCM Data Portal. Providers who worked at a clinic site during the previous calendar year must be
registered. Typically, this occurs annually during December and January. Please see the Clinic and
Provider Registration Instructions for specific details and guidance.
Clinic ID: Assigned to a clinic by the MNCM Data Portal when the clinic first registers on the MNCM Data
Portal.
Clinical Staff: Defined, for the purposes of Clinic and Provider Registration, as the following provider
types: physicians (MD or DO), advanced practice registered nurses (e.g., Certified Nurse Practitioner,
Certified Nurse Specialist, and Certified Nurse Midwife) and physician assistants (PA).
Contacts Tab: Tab in the MNCM Data Portal that lists all contacts for a particular medical group. Medical
groups can add, remove or edit contact people on this tab. While changes can be made at any time, this
information must be updated by medical groups during Clinic and Provider Registration.
Crosswalk: Process by which a unique identifier is linked to a patient’s name and date of birth so
medical records can be located by clinic staff in the case of an audit by MNCM.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2018. All rights reserved.
48

2019 Total Knee Replacement
Appendices
CSV File: Acronym for “comma separated values.” A CSV file is a common and simple format that is used
to import/transport data between systems or software applications that are not directly related (e.g.,
from a spreadsheet to a database). All data submission files are formatted as CSV files.
Data Collection Form: Form that has all patient-level data elements necessary to collect for measure. It
is optional for medical groups to use this form. It may be most useful for clinics/medical groups using
paper records.
Data Collection Guides: Document providing instructions for clinics/medical groups to submit data
counts or files to the MNCM Data Portal.
Data Comparison: Part of DDS process where clinics/medical groups are asked to review the current
measurement period’s preliminary results for each clinic compared to the last data submission for this
measure and consider any changes between the current period and the prior period. It is expected that
an explanation will be entered into a text box to account for any changes or to indicate that the data
comparison is expected.
Data Elements: Components necessary to submit data files to MNCM and to calculate measure results.
Data File: Excel template supplied on the MNCM Data Portal for DDS data submission. Templates are
specific to and formatted correctly for each measure.
Data File Transfer Selection: MDH has requested the receipt of patient level data. Medical groups must
indicate on the MNCM Data Portal if they chose to allow MNCM to share patient-level data with MDH.
This is called Data File Transfer Selection. Detailed information about the Data File Transfer Selection
options can be found in Section I of the data collection guides.
Data Portal: Secure, HIPAA-compliant portal owned by MNCM where clinics/medical groups can submit
patient-level data to MNCM for validation and accurate calculation of results.
Data Quality Checks: MNCM recommends completing several internal quality checks of the data prior to
data file submission. Quality checks improve data accuracy, reduce the likelihood of errors and ensure
the data can be validated upon audit. Please refer to specific data collection guides for guidance on data
quality checks for each measure.
Denominator: The denominator is the bottom number in a fraction. In epidemiology, it represents a
population group at risk of a specific disease. In clinical quality measurement, it is the total number of
patients (or observations) included in the calculated score.
Direct Data Submission (DDS): The DDS method was developed by MNCM to allow medical groups to
submit patient-level data for verification of results. In this process, medical groups upload files of
patient-level clinical data and clinic results are automatically calculated by the MNCM Data Portal.
MNCM validates data submitted through the DDS process before results are publicly reported.
Electronic Medical Record: A digital version of a paper chart that contains all of a patient’s medical
history from one practice, which is also known as EMR or Electronic Health Record (EHR).
Eligible Population: A group of patients who have met all eligibility criteria to be included in a measure.
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EMR Reporting Rule: Established by MDH, clinics that had an EMR in place (at any stage) for the last two
measurement periods are required to submit data on their total population.
Errors: The error and warning report will be displayed after a patient-level data file is submitted via the
MNCM Data Portal. Errors are “hard stops” in the Data Portal (e.g., dates of birth in the file are outside
the date of birth range specified for a measure) that result in the submission of a file not being allowed.
They must be corrected and a revised patient level data file must be uploaded to the Data Portal before
submission can occur.
Excel Format: Format of Excel template columns necessary to submit data file to MNCM Data Portal.
Excel Template: See Data File.
Exclusions Template: Template available on the MNCM Data Portal for tracking excluded patients. This
document will need to be uploaded to the MNCM Data Portal when the clinical data file is submitted on
measures for which exclusions are tracked. MNCM will review this list and validate a selection of records
during the validation audit. Please read more about the Exclusions Template in Section III.
Field Specifications: The detailed section in the data collection guides that provides instructions and
guidance for the collection of required data elements for measure score calculation.
Final Results: Results calculated by the MNCM Data Portal after submission of a patient level data file
after validation is completed. Final results are displayed on MNHealthScores.org.
Full-Time Equivalent (FTE): The best reflection of the time the provider practiced in a typical work week
at each clinic site over the course of a calendar year. FTE information is submitted during Clinic and
Provider Registration in the provider registration step. Please see the Clinic and Provider Registration
Instructions guide for more information.
Group and Clinic Sites Tabs: These tabs display information about the medical group and clinic sites in
the MNCM Data Portal. Information can be edited for the group or clinic sites as needed.
Home Tab: This tab displays information about all the current measures and deadlines for which the
medical group is responsible.
Hospital-Based Outpatient Clinic Locations: These are included in the physician clinic definition and
must be registered and report required measures.
Inactive Patients: Patients designated as inactive in a practice management system, billing system or
electronic medical record must be included in the eligible population if they meet measure criteria.
Insurance Coverage Data Elements, Field Specifications and Codes: Document to be used in
conjunction with the data collection guides to accurately collect and report insurance coverage data
elements.
Inter-Rater Reliability (IRR): Recommended to conduct several sample audits with all abstractors for
training purposes if more than one person will abstract data. This ensures measurement specifications
are interpreted consistently and data is collected uniformly.
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Measure Logic/Flow Charts: Used to help illustrate the identification of the eligible population and the
logic of measure calculation.
Measure Specifications: Provide detailed information about each measure, including measure
description, methodology, measurement period, denominator, exclusions and numerator. Located in
the data collection guides that are available on MNCM.org and the MDH website.
Medical Group: The highest level of the MNCM Data Portal clinic and provider registration construct.
The medical group represents a single centralized organization that operates one or more clinic sites.
Organizations define the parameters of the medical group at the time of registration and may choose to
divide clinics operated by the organization into more than one medical group. Medical groups with only
one clinic site must enter information under both the medical group and clinic sections, even though the
information will be the same. When reporting on the clinical quality measures, data for all clinic sites is
submitted to MNCM in one file via the medical group.
Medical Group ID: Assigned to a medical group by MNCM when the medical group first registers on the
MNCM Data Portal.
Multi-Specialty Clinics: A clinic site that has multiple specialties located in one building (one street
address). Medical groups have the option to register a single clinic site or register each specialty as its
own clinic site and then also register a main clinic site. How clinics decide to register depends on how
the clinic desires to have their clinical measures publicly reported on MNHealthScores.org. Please review
the Clinic and Provider Registration Instructions guide for further information about registering multispecialty clinics.
National Provider Identifier (NPI): A unique identifier for individual providers or organizations that
render health care. Health care providers who are HIPAA-covered entities obtain an NPI to identify
themselves in HIPAA standard transactions. Also referred to as Provider ID.
Newly Opened/Acquired Clinics: If a medical group opened or acquired a new clinic in the last year, the
new clinic must be registered with the medical group and must submit data with the medical group. If
the new clinic uses a different practice management system, billing system or EMR, they should follow
the same instructions and measure specifications to collect the data, and the medical group should
include the new clinic’s data in the data submission to MNCM.
Number of Eligible Patients (Exclusions Removed): Number of patients who are eligible or met the
inclusion criteria for the measure with excluded patients removed for each clinic. This count should be
entered into the MNCM Data Portal during data submission.
Number of Patients Submitting: Number of patients who are eligible and being submitted. This should
be the same number as the as Number of Eligible Patients (Exclusions Removed) if submitting total
population. If submitting a sample population, this is the number of patients in the sample population.
This number must match the number of patients in the data file.
Numerator: The numerator is the top number in a fraction. In epidemiology, it represents the number of
people in a population group who develop the disease of interest. In clinical quality measurement, it is
the number of patients that meet all specified targets of a measure.
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Patient Attribution: A patient is attributed to one clinic and provider that are considered to be
responsible for managing the patient’s care. Please refer to specific data collection guides to review
patient attribution for each measure as it they differ.
Patient-Level Data: Data elements required to calculate measure results. Data is submitted to MNCM
Data Portal via a HIPAA-secure process.
Patient Registries: A tool used by some medical groups to track patient progress and for quality
improvement purposes. MNCM cautions the use of patient registry information for quality measures.
Many registries give a “snapshot” of patients at a given time and would therefore not include all
patients according to established patient criteria or may not reflect the most recent clinical data (e.g.,
most recent blood pressure or labs). Registries that are programmed to update the patient population
and clinical results on a continual basis (24/7) could possibly be used to create data file for submission;
however, please discuss this with MNCM before use. During the validation audit, the MNCM auditor will
use the patient record not the patient registry. If a clinic uses data from a patient registry, the auditor
may find a more recent date/value in the medical record and this would be counted as an error.
Pre-Submission Data Certification: This process is intended to help identify potential data issues prior to
file submission.
Pre-Submission Data Certification Form: Document medical groups complete to outline the method for
identifying the eligible population and other details pertinent to the validation of submitted data.
Preliminary Results: Results calculated by the MNCM Data Portal after submission of a data file but
before results are fully validated.
Primary Data Contact: The person from the medical group who uploads/submits data files for the
clinical quality measures; receives communications from MNCM about data submission and other
important updates; and completes the medical group’s annual registration of the clinics and clinical staff
on the MNCM Data Portal. It is important that the Primary Data Contact information for medical groups
remains up-to-date to ensure MNCM communication is received by the appropriate person in a timely
manner.
Provider File: Excel Template available on the MNCM Data Portal for Clinic and Provider Registration.
This document is uploaded to the MNCM Data Portal during registration.
Provider ID: Created by medical group/clinic for providers who do not have an NPI. This ID will be used
in the data file submission to MNCM.
Provider Type: Medical Doctor (MD, including physicians who have medical degrees from other
countries such as MBBCH, MBBS, MBCHB); Doctor of Osteopathy (DO); Physician Assistant (PA) or
Advanced Practice Registered Nurse (e.g., Certified Nurse Practitioner, Certified Nurse Specialist,
Certified Nurse Midwife) are providers that are required to be registered during Clinic and Provider
Registration. Refer to the specific measure specifications for eligible provider types required to report
clinical data for each measure as they differ.
Provider Registration: See Clinic and Provider Registration.
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Provider Specialty Code: Codes generated by MNCM to indicate the board-certified specialty of
providers. The codes are included in the provider registration file and DDS data file. Please see the Clinic
and Provider Registration Instructions guide as well as each data collection guide for further guidance.
Providers Tab: This tab displays all of the information about providers submitted during Clinic and
Provider Registration.
REL: Acronym referring to data elements of race, Hispanic ethnicity, preferred language and country of
origin.
REL Best Practice: Data collection best practice methods for REL data elements include: allowing
patients to self-report race and Hispanic ethnicity, preferred language and country of origin as well as
NOT using a multi-racial category; allowing patients to select more than one race; and using a system
that allows the collection and reporting of more than one race for each patient. For more information
about collecting this data from patients, refer to the Handbook on the Collection of Race Ethnicity and
Language Data available on MNCM.org under Submitting Data > Training & Guidance > Data Collection
Guides.
REL Data Elements, Field Specifications and Codes: Document to be used in conjunction with the data
collection guides to accurately collect and report REL data elements.
Required Exclusions: This type of exclusion is required. A medical group must remove patients from
data submission who meet the criteria described in the Required Exclusions section of the Measure
Specifications. These exclusions have evidence that they are clinically appropriate or that the frequency
and impact of the inclusion of these patients would distort the calculated result.
Results Tab: This tab includes final data results and file downloads from prior submission cycles, as well
as charts of current and historical results.
Resources Tab: This tab is organized by topic or measure, and houses data submission guides, tools and
frequently asked questions by measure.
Roll-up: Process by which multiple clinics report data under one clinic. Clinics can report clinic quality
data as one clinic if they meet all of the three following criteria: A) have common ownership; B) have a
majority (more than half) of common clinical staff working across the multiple locations (these clinical
staff must rotate between all of the clinic locations); and C) the total clinical staff across all locations is
no greater than 20 FTEs. Please see clinical staff for further details.
Sample Population: A random selection of patients to be submitted for clinical measures. The sample
population is drawn from the total eligible population. The minimum required sample is 60 patients per
clinic site. See the EMR Reporting Rule to determine eligibility for sample population submission. Not all
measures allow sample population submission. Please see data collection guides for more detailed
instructions.
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Statewide Quality Reporting and Measurement System (SQRMS): State health reform law passed in
2008. Under this law with specific directives within Minnesota Statutes, section 62U.02, all physician
clinics are required to register and submit data on measures to be publicly reported to the
Commissioner of Health. To implement physician clinic registration and the collection of quality
measurement data, MDH developed SQRMS, created through Minnesota Rules, Chapter 4654. MDH has
contracted with MNCM to assist with implementing SQRMS. Under this contract, MNCM supports
physician clinics in meeting registration and measure requirements
Summary of Changes: Area at the beginning of each data collection guide which highlights changes from
the previous year.
System Query: Process by which data elements are pulled from chart system (EMR or manual) by
clinics/medical groups.
Total Population: Consists of the entire eligible population. Please refer to the specific data collection
guides for further instructions on how to submit total population.
Two-Week Review Period: Period after data submission in which clinics/medical groups can review their
preliminary results in comparison with other clinics/medical groups. This is a very important validation
step to ensure accurate results before public reporting.
Urgent Care Clinics: A type of walk-in clinic, either stand-alone or offered as a service of a multispecialty clinic, that primarily treats illness or injuries requiring immediate care, but not serious enough
to require an ER visit. Stand-alone urgent care clinics must register and complete an annual Health
Information Technology (HIT) survey; however, urgent care clinics are not required to report on clinical
quality measures.
Value Set: A set of administrative codes used to define a concept related to the measure construct (e.g.
denominator, exclusions) using standard coding systems (e.g. ICD-10, CPT, LOINC).
Value Set Dictionary: A spreadsheet-based list of codes by measure. Contains all Value Sets applicable
to a given measure.
Warnings: The error and warning report is displayed in the MNCM Data Portal after data file submission.
Warnings should be reviewed to determine if corrections are needed.
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